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Learn more

This guide and other resources for SMART Board 800 series interactive 
whiteboards are available in the Support section of the SMART website 
(smarttech.com/support). Scan this QR code to view these resources on your 
mobile device.

FCC warning
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the manufacturer’s instructions, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.
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Microsoft Corporation in the U.S. and/or other countries. Mac, OS X and Finder are registered trademarks of Apple, Inc., registered in the U.S. and other countries. All other 
third-party product and company names may be trademarks of their respective owners.

Copyright notice
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form by any means without the prior written consent of SMART Technologies ULC. Information in this manual is subject to change without notice and does not represent a 
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Important information

Before you install and use the SMART Board® 800 series interactive whiteboard, read and understand 
the safety warnings and precautions in this guide. These safety warnings and precautions describe the 
safe and correct operation of the interactive whiteboard and its accessories, helping you to prevent 
injuries and equipment damage. Ensure that the interactive whiteboard system is always being used 
correctly.

Note 

In this document, the term “interactive whiteboard” refers to the interactive whiteboard and its 
accessories and options.

Safety warnings and cautions
Warning 

 l Ensure that any cables extending across the floor to the SMART product are properly fastened 
together and marked to avoid a trip hazard.

 l To reduce the risk of fire or electric shock, do not expose the SMART product to rain or moisture.

 l Refer to the safety warnings and precautions published by the projector manufacturer. Do not 
stare (or allow children to stare) directly into the projector’s beam of light.

 l Do not touch (or allow children to touch) the projector. It can become extremely hot during 
normal operation.

 l Do not stand (or allow children to stand) on a chair to touch the surface of the SMART product. 
Instead, safely fix the product at the appropriate height on a wall or use a SMART height-
adjustable floor stand.

 l Do not climb (or allow children to climb) on a wall- or stand-supported SMART Board 
interactive whiteboard.
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 l Safely mounting the interactive whiteboard requires two people because it is too heavy for one 
person to safely maneuver. When you and your assistant lift the interactive whiteboard, support 
its weight at the bottom, avoiding the corner cameras, and balance the top with your other 
hands.

 l The weight of the interactive whiteboard is approximately 52 lb. (23.7 kg) for the SMART Board 
880 interactive whiteboard and 61 lb. (27.5 kg) for the SMART Board 885 interactive whiteboard. 
Check your local building codes to ensure that the wall can support this weight, and use 
appropriate mounting hardware for the type of wall.

 l To prevent injury or product and property damage, use only the mounting hardware supplied 
with the SMART Board 800 series interactive whiteboard when you install the product on drywall. 
The mounting hardware provided with other interactive whiteboards may not be strong enough 
to support the weight of a SMART Board 800 series interactive whiteboard.

 l Use two wall-mounting brackets to install SMART Board interactive whiteboards with a diagonal 
width of 87" (221 cm).

 l For operating safety and to prevent damage to the interactive whiteboard, connect its USB 
connector, or SMART connection extenders, only to a computer that has a USB compliant 
interface and that bears the USB logo. In addition, the USB source computer must be compliant 
with CSA/UL/EN 60950 and bear the CE mark and CSA and/or UL mark(s) for CSA/UL 60950.

 l To prevent injury or product damage as a result of tipping, mount the interactive whiteboard only 
on a floor stand that is certified for use with SMART Board 800 series interactive whiteboards, 
such as the SMART FS670 Mobile Floor Stand or SMART HAWM FS-UX Mobile Height-Adjustable 
Floor Stand. Do not modify the interactive whiteboard or the floor stand to make them 
compatible.

 l Move a floor stand-supported SMART Board interactive whiteboard with care. Sudden stops, 
excessive force and uneven surfaces may cause the product to overturn.

Caution 

 l If you’re replacing a SMART Board 500 or 600 series interactive whiteboard with the heavier 
SMART Board 800 series interactive whiteboard on drywall, you must remove the wall-mount 
bracket and mounting hardware, and then install all the mounting hardware and brackets 
supplied with the SMART Board 800 series interactive whiteboard instead.

 l If you need to lean your interactive whiteboard against a wall, make sure that it remains in an 
upright position, resting on its pen tray brackets, which are designed to sustain the interactive 
whiteboard’s weight. Do not rest the interactive whiteboard on its side, on the top of its frame or 
on the corners of the frame where the cameras are located.
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 l Do not add any extra weight or pressure to a wall-mounted interactive whiteboard or its pen 
tray. SMART designed the brackets to support only the weight of the interactive whiteboard and 
its accessories during normal use.

 l There are no user-serviceable parts inside the pen tray.

 l When transporting the SMART Board interactive whiteboard, repack it with the original 
packaging. This packaging was designed to provide the best possible protection against shock 
and vibration.

 l Do not use compressed air to clean the cameras.

 l Do not allow cleaner to flow onto the infrared (IR) reflective material at the edges of the 
interactive whiteboard frame, or into the pen tray slots.

 l Do not set up and use the interactive whiteboard in an area with excessive levels of dust, humidity 
or smoke.

 l If the SMART Board interactive whiteboard requires replacement parts, make sure that the 
service technician uses replacement parts specified by SMART Technologies.

Other precautions
If you own a SMART product other than a SMART Board 800 series interactive whiteboard, refer to the installation manual for that 
product for relevant warnings and maintenance instructions.
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The SMART Board 800 series interactive whiteboard is the most advanced and intuitive touch sensitive, 
front projection interactive whiteboard in the world, featuring SMART’s proprietary DViT® 
(Digital Vision Touch) technology. Its modular and expandable hardware and software architecture 
enables you to do everything you can do at your computer—open and close applications, meet with 
others, create or edit documents, visit websites, play and manipulate video clips and more—just by 
touching the interactive surface.

When you use SMART software, you can also write over any application in digital ink using a pen tray 
pen or your finger, and then save these notes for future reference and distribution.
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Identifying the components of the SMART Board 
800 series interactive whiteboard
Use the following illustration to familiarize yourself with the parts of the interactive whiteboard.

Notes 

 l Your interactive whiteboard’s pen tray might look different than the one illustrated above. The is 
because the left and right sides of the pen tray are modular.

 l The modular options for the left side of the pen tray include the basic power module (illustrated 
above), the Extended Control Panel (ECP), and the Appliance Control Panel (ACP).

 l The module options for the right side of the pen tray include the blank cover (illustrated above), a 
CAT 5 USB extender module, and a wireless connection module.
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Highlights

Software
To use all the interactive whiteboard‘s features, ensure that you have the latest version of SMART 
software and SMART Product Drivers installed on your computer. You can download the latest software 
from smarttech.com/downloads.

Dual sketch capabilities
Two people can each pick up a pen and draw on the interactive surface at the same time, providing a 
higher degree of interactivity.

SMART Ink
The SMART Ink™ feature smoothes out the appearance of the digital ink, which improves the legibility of 
your handwriting as you write over applications, websites and videos. The ink becomes an object that 
you can move and manipulate.

Touch and gestures
You can perform mouse functions with your finger, and write and erase digital ink with a pen tray pen or 
the eraser. The object awareness feature enables you to pick up a pen, and then write, select or erase 
without replacing the pen.

Pen tray
The SMART Board 800 series interactive whiteboard features a modular pen tray with an intuitive new 
design. As well as two pens and an eraser, pen tray buttons activate the pen’s color, the on-screen 
keyboard, right-click, Orientation and Help functions.

Optional Extended Control Panel (ECP), Appliance Control Panel (ACP), CAT 5 USB extender, and 
wireless connection modules are also available.

Durable surface and dry erase
The hard-coated surface is scratch resistant, optimized for projection, compatible with dry-erase 
markers and easily cleaned.

Wall-mount bracket
Wall mount brackets enable you to install the SMART Board interactive whiteboard simply and securely.

https://www.smarttech.com/downloads
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Cables
Connect the SMART Board interactive whiteboard to your computer with the included, standard USB 
cable, and to a wall outlet with the included power supply and cords.

Security cable lock
Lock the interactive whiteboard with a security cable (not included) to help safeguard it from theft.

Understanding how the SMART Board interactive 
whiteboard works
The interactive whiteboard functions as an input device for a computer, just like a mouse, enabling you 
to work in any application on the computer from the interactive whiteboard.

When you touch the interactive whiteboard’s surface, the four cameras located in the interactive 
whiteboard’s corners detect the contact’s horizontal and vertical (or x,y) coordinates. The computer 
interprets these coordinates and moves the pointer to the corresponding location on the interactive 
whiteboard’s surface.

Other components
Using the interactive whiteboard requires two additional 
components: a computer and a digital projector.

These components work together as follows:

 l The computer runs an application and sends the image to 
the projector.

 l The projector casts the image onto the interactive 
whiteboard.

 l The interactive whiteboard acts both as your computer’s 
monitor and its input devices, that is, its mouse and 
keyboard, enabling you to control any application by touching the interactive surface.
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When you install SMART Product Drivers on the computer, the touch of your finger on the interactive 
surface becomes a mouse click, enabling you to control the computer from the interactive whiteboard. 
When you use a pen from the pen tray, the system detects which tool you’re using. 
SMART Product Drivers then interacts with the computer’s mouse driver to change the pointer to a 
colored pen, enabling you to write in digital ink on the desktop or any open application. When you use 
the eraser, you can erase the digital ink. You can even use your finger on the interactive whiteboard’s 
surface without returning the pen tray tools—automatic object awareness determines the tool you’re 
using on the interactive surface. You can also save your notes to a .notebook file, or directly into any Ink 
Aware application.

Included parts and accessories
The SMART Board 800 series interactive whiteboard includes the following accessories.

Pens
There are two pens included with the interactive whiteboard. Pick up a pen 
and press one of the four color buttons on the pen tray (black, red, green or 
blue) to change the color of digital ink you write with on the interactive 
whiteboard. 

Tip 

To learn how to distinguish SMART Board 800 series interactive whiteboard pens from other SMART 
product pens, see SMART product pens comparison (docs.smarttech.com/kb/171230).

Eraser
The eraser is rectangular like a traditional chalkboard eraser.

 

Wall-mounting kit
The 32" (81.3 cm) wall-mount bracket comes with five screws and toggle bolts, enabling you to wall-
mount the interactive whiteboard simply and securely. SMART Board 885 interactive whiteboards come 
with two wall-mounting kits.

https://docs.smarttech.com/en/kb/171230
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USB cable
A 16' 5" (5 m) USB cable enables you to connect your SMART Board 800 series 
interactive whiteboard to a USB receptacle on your computer.

 

Extended Control Panel (ECP)
If your interactive whiteboard is bundled with a SMART or Epson for SMART 
projector as part of a projector system, the Extended Control Panel (ECP) 
attaches to the left side of the interactive whiteboard pen tray. The ECP 
features controls for power, source selection and volume adjustment, as well 
as a USB A receptacle for USB drives.
 

Appliance Control Panel (ACP)
If your interactive whiteboard is bundled with a SMART projector and 
appliance as part of a projector system, the Application Control Panel (ACP) 
attaches to the left side of the interactive whiteboard pen tray. The ACP 
features a power button and LCD control screen.

 

Power supply
The SMART Board 800 series interactive whiteboard receives power from a wall outlet through the 
included country-specific power supply and cables.

Note 

If your interactive whiteboard is bundled with a SMART projector as part of a projector system, power 
for the interactive whiteboard is provided by the SMART projector through a separate power supply.

Optional accessories
You can add a variety of optional accessories to the SMART Board 800 series interactive whiteboard to 
best meet your specific needs, including a CAT 5 USB extender module or a wireless connection module.

You can purchase these items when you order an interactive whiteboard, or later from your authorized 
SMART reseller (smarttech.com/us/Where). For more information about accessories, go to 
smarttech.com/accessories.

https://www.smarttech.com/where
https://smarttech.com/accessories
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Environmental requirements
Before installing the interactive whiteboard, review the following environmental requirements.

Environmental 
requirement

Parameter

Operating temperature   41°F to 95°F (5°C to 35°C)

Storage temperature   -40°F to 120°F (-40°C to 50°C)

Humidity   5% to 80% relative humidity, non-condensing

Water and fluid 
resistance

 l Intended for indoor use only. Doesn’t meet any salt-spray or water 
ingress requirements. 

 l Don’t pour or spray liquids directly onto the interactive whiteboard or 
any of its sub-components. These liquids might get into areas where 
they could damage sensitive electronic components. Refer to  Keeping 
the writing surface clean on page 44 for detailed instructions on 
cleaning the interactive whiteboard.

Dust  l Moderate dust. Intended for use in office and classroom environments. 
Not for industrial use where heavy dust and pollutants can cause 
malfunctions or impaired operation.

 l Designed for pollution degree 1 (P1) as per EN61558-1, which is defined 
as “No pollution or only dry non-conductive pollution.”

Conducted and 
radiated emissions

  EN55022/CISPR 22, Class A
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Installing the SMART Board interactive whiteboard
Follow the procedure outlined in the installation document included in the interactive whiteboard’s box 
to install the interactive whiteboard. If you purchased a floor stand, wall-mount or an interactive 
whiteboard system that includes a projector or other components, refer to the installation documents 
included with these components. The optimal mounting height is 77" (196 cm) from the floor to the center 
of the installation brackets. However, consider the general height of your user community when you 
choose a location for wall-mounting the interactive whiteboard. If you mount the interactive whiteboard 
too low, it might force tall people to bend over uncomfortably. If it’s too high, other people might need to 
reach up too far. Also remember to leave enough room on either side of the interactive whiteboard so 
that you can stand beside it.

Warning 

 l Safely mounting the interactive whiteboard requires two people. It is too heavy for one person to 
safely maneuver. When you and your assistant lift the interactive whiteboard, support its weight 
at the bottom, avoiding the corner cameras, and balance the top with your other hands.

 l The weight of the interactive whiteboard is approximately 52 lb. (23.7 kg) for the 880 model and 
61 lb. (27.5 kg) for the 885 model. Check your local building codes to ensure that the wall can 
support this weight, and use appropriate mounting hardware for the wall type.

Caution 

 l If you need to lean the interactive whiteboard against a wall before you mount it, make sure it 
remains in an upright position, resting on the pen tray brackets, which can sustain the weight of 
the interactive whiteboard.

 l Do not rest the interactive whiteboard on its side or on the top of the frame, or on the corners 
where the cameras are located.

Installation tips
 l Ensure the bottom of the pen tray is unobstructed at all times, because you will need to access it if 

the interactive whiteboard requires service.

 l Install the interactive whiteboard on a flat, plumb wall.

 l If you’re installing the interactive whiteboard on drywall, use all the toggle bolts supplied. Because 
one of the mounting bracket holes aligns with a wall stud, use appropriate hardware in that hole 
instead of a toggle bolt.
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 l Ensure that the power supply cable is connected to the correct receptacle in the pen tray, as shown 
below.

Replacing an existing interactive whiteboard on drywall
If you’re replacing a SMART Board 500 or 600 series interactive whiteboard with the heavier 
SMART Board 800 series on drywall, you must remove the wall-mount bracket and mounting hardware, 
and then install all the mounting hardware and brackets supplied with the SMART Board 800 series 
interactive whiteboard instead.

Caution 

To help ensure that the interactive whiteboard is mounted correctly, make sure the color of the wall-
mount hanger on the back of the interactive whiteboard and the color of the wall-mount bracket are 
the same.

Securing the pen tray to the interactive whiteboard
Because the pen tray is detachable, you might want to safeguard it—and the interactive whiteboard—by 
anchoring it with a security cable (not included). Underneath the pen tray, you’ll find a lock slot that 
accommodates a security cable, such as a Kensington® lock.
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Important 

Securing the pen tray can provide theft deterrence for the interactive whiteboard because the screws 
that secure the interactive whiteboard to the wall are located directly behind the pen tray and cannot 
be removed without first detaching the pen tray. In effect, when you secure the pen tray, you also 
secure the interactive whiteboard if the security cable is tight.

To secure the pen tray to the interactive whiteboard

 1. Loop the security cable behind the pen tray brackets before you secure them to the wall.

 2. Thread the lock end of the cable through the loop end of the cable.

 3. Verify that the cable is tight enough that you can’t remove the pen tray while the lock is in place, and 
then install the pen tray.

 4. Insert the prong end of the security cable into the lock slot, and then complete the pen tray 
installation by locking it.

Securing the pen tray to the brackets
Because you can remove the pen tray without tools, you might want to securely attach it to its brackets.

To secure the pen tray to the brackets

  Insert two No. 8/M4 screws (not included) into the holes indicated by a lock symbol on the bottom of 
the pen tray.
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After installing the interactive whiteboard, connect a computer to it. The interactive whiteboard will be 
touch sensitive after you install SMART Product Drivers on the connected computer.

You can also connect a guest laptop.

Connecting the interactive whiteboard to the 
computer
The interactive whiteboard has a USB 2.0 peripheral interface that runs at speeds of up to 12 Mbps. The 
unit works with full-speed USB 2.0- and USB 1.1-compliant interfaces.

Connect the interactive whiteboard and the computer using the included 16' 5" (5 m) USB cable.

How you connect the interactive whiteboard to the computer depends on how the interactive 
whiteboard is configured:

 l If a basic power module is attached to the left side of the pen tray, connect the USB cable from the 
computer to the USB Type-B receptacle on the bottom of the pen tray.

 l If an Extended Control Panel (ECP) or Appliance Control Panel (ACP) is attached to the left side of 
the pen tray, connect the USB cable from the computer to one of the USB Type-B receptacles on the 
ECP or ACP. The ECP or ACP then connects to the USB Type-B receptacle on the bottom of the pen 
tray.

 l If a CAT 5 USB extender or wireless connection module is attached to the right side of the pen tray, 
use that module to connect the computer to the interactive whiteboard.
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Warning 

For operating safety and to prevent damage to the interactive whiteboard, connect its USB connector, 
or SMART connection extenders, only to a computer that has a USB compliant interface and that 
bears the USB logo. In addition, the USB source computer must be compliant with CSA/UL/EN 60950 
and bear the CE mark and CSA and/or UL marks for CSA/UL 60950.

Consult the installation document included with the product for instructions on how to install, connect 
and secure the interactive whiteboard.

After the interactive whiteboard is installed and connected to your computer, you can install 
SMART Product Drivers.

Installing SMART Product Drivers
After you install SMART Product Drivers on the computer, the SMART Board interactive whiteboard’s 
surface will respond to the touch of your finger or a pen tray pen. SMART Product Drivers includes the 
tools you need to control computer applications with your finger or a pen, and to write over them in 
digital ink.

Note 

If you don’t install SMART Product Drivers, interactive whiteboard tools such as the pens and the 
eraser don’t work, but you can move the mouse pointer and perform mouse functions by touching the 
interactive surface.

To install SMART Product Drivers

 1. Download the SMART Product Drivers.exe (Windows® computers) or SMART Product 
Drivers.dmg (Mac computers) file to the computer from the disc or link included with the 
interactive whiteboard or from smarttech.com/downloads.

Note 

In most cases, SMART Product Drivers is downloaded and installed automatically when you install 
SMART Notebook® or SMART Meeting Pro® software.

 2. If necessary, turn on the projector to see the projected computer image on the interactive 
whiteboard.

 3. Locate the installation program and follow the on-screen instructions to complete the installation.

SMART System Menu opens automatically.

https://www.smarttech.com/downloads
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 4. If SMART System Menu doesn’t open:

 o On a Windows 7 computer, select Start > All Programs > SMART Technologies > SMART 
System Menu.

On a Windows 8 computer, go to the Apps screen, and then scroll to and select SMART 
Technologies > SMART System Menu.

On a Windows 10 computer, select Start > All apps, and then scroll to and select SMART 
Technologies > SMART System Menu.

 o If you have a Mac computer, open Mac HD, and then select Applications > SMART Product 
Drivers > SMART Board Tools.app.

The Ready light in the interactive whiteboard’s pen tray turns from flashing green to solid green and 
the SMART Board icon appears in the Windows notification area or Mac Dock, indicating that the 
interactive whiteboard is communicating successfully with SMART Product Drivers.

You can now pick up a pen from the pen tray and write over the desktop or any projected application, 
and use all the other features of the SMART software. For more information on using SMART software, 
press the SMART Board icon, and then select Help.

Configuring the computer settings
For optimal configuration, use the following settings for the computer connected to the interactive 
whiteboard.

Setting Details

Recommended settings Configure the computer’s power management settings to turn off the 
monitor after one hour of inactivity and to put the hard disks into 
standby mode after two hours. This extended period prevents the 
computer from shutting down unexpectedly (for example, during 
presentations or meetings that have gaps in computer activity).
The computer will stop sending a video signal to the projector after a 
period of idle time, which may trigger the projector to go into standby 
mode. Similarly, you can put the projector in standby mode by 
following the manufacturer’s instructions included with the projector. 
To change the settings, see the instructions included with your 
computer’s operating system.
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Setting Details

Matching the computer’s 
resolution to the projector’s 
resolution

Ensure that the resolution settings for the projector and computer 
match. If the computer’s resolution doesn’t match the projector’s native 
resolution, the image won’t appear correctly or will be distorted. 
Determine the projector’s native resolution, indicated in the projector’s 
user’s guide, and then set the computer’s resolution to match. You can 
change the computer’s resolution in Windows Control Panel or in the 
Mac System Preferences. If you need further help changing the 
computer’s resolution, see the instructions included with your 
computer’s operating system.
See Getting the Best Image Quality on Your SMART Board Interactive 
Whiteboard (docs.smarttech.com/kb/127199) for more information.
You might also need to adjust the computer’s refresh rate to obtain the 
best results. Set the computer to an initial refresh rate of 60 Hz, and 
then adjust this rate up or down until you determine the ideal refresh 
rate. For more information on changing the computer’s refresh rate, 
see the instructions included with your computer’s operating system.

Calibrating and orienting the interactive whiteboard
Perform the brief calibration and user orientation procedures (page 22) to ensure the interactive 
whiteboard interprets the location of your touch accurately.

Connecting a guest laptop
If you want to connect a guest laptop without installing SMART Product Drivers on it, disconnect the USB 
cable from the resident computer, and then connect it to the laptop. You’ll immediately have touch 
control of the interactive whiteboard, but won’t be able to use digital ink. You’ll also need to connect a 
video cable between the laptop and projector.

Note 

With a laptop connected, the Ready light on your interactive whiteboard flashes until you install 
SMART Product Drivers. This is normal. See Power buttons and indicators on page 27 for more 
information about Ready light states.

You must also install SMART Product Drivers (refer to page 19) on your laptop if you want to use all the 
features of the interactive whiteboard.

https://docs.smarttech.com/en/kb/127199
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Perform the brief calibration and user orientation procedures to ensure the interactive whiteboard 
interprets the location of your touch accurately.

Calibrating the interactive whiteboard
Digital cameras in the corners of the interactive whiteboard track the position of the pens, eraser and 
your finger on the interactive surface, and then send the information to the SMART software. SMART 
software interprets this information as mouse clicks, digital ink or ink removal in the appropriate location.

The first time you connect the interactive whiteboard, you should see a pop-up bubble telling you to 
calibrate the interactive whiteboard. If you don’t, press the Help button on the pen tray to start the 
calibration process as described below. This process ensures that the cameras accurately track your 
finger and the pens on the interactive surface.

Important 

 l If you have not used the interactive whiteboard before, you must perform a calibration. If the 
system detects incorrect calibration parameters, a warning bubble may also appear 
recommending that you perform a calibration.

 l Make sure the projected image fully spans the interactive surface.

To calibrate the interactive whiteboard

 1. Click the SMART Board icon in the Windows notification area or Mac Dock, and then click 
SMART Settings.

 2. Select SMART Hardware Settings.

 3. If you have more than one SMART product connected, select the appropriate interactive 
whiteboard.
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 4. Click Advanced Settings, and then click Calibrate.

The Calibration window opens. This can take a few moments while the system sets up.

 5. Use the tip of a pen tray pen to press the red targets as they appear. Move the tip to the center of 
each target until the target turns green, and then lift the pen. When you remove the pen, the target 
moves to the next calibration point.

Note 

You can re-calibrate a target by pressing the left arrow key on the keyboard, or the Keyboard or 
Right-click buttons on the pen tray.

 6. Continue until you have pressed all the targets.

When you’ve pressed all the targets, a message appears saying that the calibration was successful, 
and then the orientation screen appears.

Orienting the interactive whiteboard
After you install SMART Product Drivers on the computer and calibrate the interactive whiteboard, an 
orientation screen appears. The 4-point orientation process ensures that the calibration coordinates are 
accurately associated with the relative location of the projected image on the interactive surface.

Orient the interactive whiteboard if the projector or interactive whiteboard has moved since you last 
used it, or whenever the mouse pointer isn’t properly aligned with your finger or a pen tray pen when 
you touch the interactive whiteboard’s surface.

To orient the interactive whiteboard

 1. Press the Orientation button on the pen tray (see Power buttons and indicators on page 27).

The orientation screen appears.

 2. Pick up a pen from the pen tray.
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 3. Beginning at the upper-left corner of the screen, touch the center of the target firmly with the tip of 
the pen. When you remove the pen, the target moves to the next orientation point. Try not to flick the 
pen when you lift it from the interactive surface, and make sure that you lift it from the screen at a 
90° angle.

Note 

Although you can use your finger to orient your interactive whiteboard, a fine-point tool such as a 
pen tray pen provides greater precision when touching the targets. The more precisely you touch 
the targets, the more accurately your finger or pen tray pen appears on the interactive screen.

 
Good orientation point

(The pen touches the center of the target.)

Poor orientation point

 

 4. Repeat step 3 until you complete the orientation process. 

The orientation screen closes. 

Note 

You can re-orient a target by pressing the left arrow key on your keyboard, or the Keyboard or 
Right-click buttons on the pen tray.
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Getting started
Once you install the SMART Board interactive whiteboard and software and complete the calibration 
and orientation, you can use the interactive whiteboard to write, erase and move objects, open 
applications, use Ink Aware programs and save your notes on the computer.

Turning the interactive whiteboard on and off
How you turn on the interactive whiteboard, computer, and projector depends on how the interactive 
whiteboard is configured:

 l If a basic power control module is attached to the left side of the pen tray (because the interactive 
whiteboard is not part of a projector system), turn on the computer, turn on the projector, and then 
press the Power button on the basic power control module to turn on the interactive whiteboard.

 l If an Extended Control Panel (ECP) is attached to the left side of the pen tray (because the 
interactive whiteboard is part of a projector system), turn on the computer and then press the 
Power button on the ECP to turn on the projector and the interactive whiteboard.

 l If an Appliance Control Panel (ACP) is attached to the left side of the pen tray (because the 
interactive whiteboard is part of a projector system with an appliance), turn on the computer and 
then press the Power button on the ECP to turn on the projector, the interactive whiteboard, and the 
appliance.

Each time you turn on the interactive whiteboard, the pen color buttons cycle twice, and then the light 
comes on only for the ink color you select.

When your computer is on and the Power button is off, the interactive whiteboard is in Standby mode. 
Press the Power button to wake up the interactive whiteboard. When you finish, press the Power button 
again to return it to Standby mode.
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Power buttons and indicators
The left side of the pen tray has Power, Orientation and Help buttons, as well as the Ready light.

Note 

The above diagram shows the basic power module:

 l For information on the additional features of the Extended Control Panel (ECP), see Using the 
Extended Control Panel (ECP) on the next page.

 l For information on the additional features of the Application Control Panel (ACP), see Using the 
Application Control Module (ACM) on page 30

Component Description

Power button Press this button to put your interactive whiteboard into Standby mode when 
it isn’t in use, or to restore full power to it when you need to use it. Ensure that 
the interactive whiteboard is connected to your computer and to a wall 
power outlet.

Orientation button Press this button to start the orientation process. Orienting your interactive 
whiteboard ensures that the mouse pointer or digital ink appears directly 
below your finger or pen tray tool when you touch the interactive surface. 
Refer to page 23 for information on performing an orientation procedure.
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Component Description

Help button Press this button to access on-screen Help options, including links to online 
Help files, troubleshooting options and contact information for 
SMART Support.

Ready light This light indicates the status of the interactive whiteboard’s controller 
module. The Ready light is solid green when the system is working properly.

The following table shows the Ready light’s normal states.

Ready light state Description

Solid red Your interactive whiteboard is receiving power from the power cable, but 
isn’t communicating with a computer.

Flashing green Your interactive whiteboard is receiving power and is communicating 
successfully with your computer’s USB HID driver. SMART Product Drivers 
isn’t installed.

Note 

In HID mode, interactive whiteboard tools such as the pens and the eraser 
don’t work, but you can move the mouse pointer and perform mouse 
functions by touching the interactive surface. The Right-click button on the 
pen tray might work, depending on the version of operating system you’re 
using. Neither the Keyboard nor the Help button work in HID mode.

Solid green Your interactive whiteboard is receiving power and is communicating 
successfully with SMART Product Drivers.

Flashing amber The controller module is in a service mode or the firmware is being updated.

Using the Extended Control Panel (ECP)
If your interactive whiteboard is bundled with a SMART or Epson for SMART projector as part of a 
projector system, the Extended Control Panel (ECP) attaches to the left side of the interactive whiteboard 
pen tray. The ECP gives you control of the interactive whiteboard’s basic operations. Press the Power  
button on the ECP to put the projector into Standby mode or to turn it on. Press the ECP’s Input button to 
switch sources on the projector.

Important 

Do not disconnect cables from the ECP to connect peripheral devices because you could disconnect 
controls for the interactive whiteboard.
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The following diagram and table describe the components of the ECP.

Number Function

Left side

1 USB A receptacle (for USB drives)

Note 

USB drives that you connect to this receptacle are accessible only to the room 
computer (the computer connected to the USB1 receptacle).

Front

2 Interactive whiteboard and projector Power  button and status indicator light

3 Projector volume control

4 Projector input selection

Back

5 Two mini USB B receptacles (connect to room computer and laptop)

6 11-pin connector (connects to projector integration cable harness)

7 4-pin connector (for optional room control)

Note 

Use an 800 series control cable (Part No. SBX8-CTRL) to convert the 4-pin connector to a DB9F RS-232 
connector for use with a third-party room control system. You can purchase an SBX8 series control 
cable from your local SMART reseller.
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Using the Application Control Module (ACM)
If your interactive whiteboard is bundled with a SMART projector and appliance as part of a projector 
system, the Application Control Panel (ACP) attaches to the left side of the interactive whiteboard pen 
tray. The ACP gives you control of the basic operations of your interactive whiteboard system. Press the 
Power  button on the ACP to start the interactive whiteboard system. The button flashes green until the 
interactive whiteboard system is on. Use the LCD touch screen on the ACP to turn the interactive 
whiteboard system off and on, control volume, switch inputs and applications, control projector and LCD 
settings, and access system and status information. You can also set your system to low power mode by 
selecting Turn Off on the LCD touch screen.

Important 

Do not disconnect cables from the ACP to connect peripheral devices because you could disconnect 
controls for the interactive whiteboard.

Note 

Low power mode reduces the power consumption of your interactive whiteboard system when it’s in 
Shutdown mode.

To set the projector system to Low power mode, access the low power mode options through the LCD 
touch screen’s system settings.

The following diagrams and table describe the components of the ACP.

    

Number Function

1 USB A receptacle (for USB drives)

2 Power  button (for appliance only)

3 LCD touch screen

4 Mini USB B receptacles (x2) (connect to appliance and laptop)

5 2.0 mm male barrel connector to appliance (DC-out)
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Number Function

6 2.5 mm male barrel connector to power supply (DC-in)

7 15-pin connector (connects to ACP harness cable)

Using the pen tray
In addition to providing a convenient place to hold the pens and the eraser, the pen tray on the 
SMART Board 800 series interactive whiteboard has several controls, sensors and indicators.

Pen tray buttons
In the center of the pen tray, there are six buttons. The middle four change the color of digital ink for the 
two pen tools. The buttons on either side of the pen color buttons default to the on-screen keyboard (left 
button) and right-click (right button) functions.

You can customize the pen, eraser and button settings. For example, you can change line transparency, 
color and style; you can change the width of the eraser; and you can change the Keyboard and Right-
Click button settings so that they perform another action.

Note 

Pressing the Keyboard and Right-Click buttons simultaneously starts the orientation.
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Customizing the pen tray buttons
You can use the SMART control panel to customize the SMART hardware settings, including the pen, 
eraser and button settings.

To customize the button settings

 1. Press the SMART Board icon in the Windows notification area or Mac Dock, and then select SMART 
Settings.

SMART Settings opens.

 2. Press SMART Hardware Settings and select the SMART Board interactive whiteboard.

 3. Press Pen and Button Settings from the drop-down list, and then select the button you want to 
customize.

 4. Follow the on-screen instructions.

For more information about customizing the settings, open the online Help by pressing the Help button 
on the pen tray, selecting Help Center, and then selecting SMART Hardware Settings.

Using the Ready light
The Ready light is on the pen tray’s left side beside the Help button. It indicates the status of the controller 
module.

Note 

The following illustration shows the pen tray for the SB880 and SB885 model interactive whiteboards. 
The SB880E and SB885E models feature an Extended Control Panel in place of the power module.

SeeUsing the Extended Control Panel (ECP) on page 28

The Ready light is solid green when the system is working properly.
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The following table shows the Ready light’s normal states.

If the Ready light is... The interactive 
whiteboard...

Actions

Off Isn’t receiving power or is in 
Standby mode.

 l Press the Power button on the pen tray 
to bring the interactive whiteboard out 
of Standby mode.

 l Ensure that the interactive whiteboard is 
connected to a wall outlet.

Solid green Is receiving power and is 
communicating successfully 
with SMART Product Drivers

N/A

Solid red Is receiving power from the 
power cable but isn’t 
communicating successfully 
with the computer.

 l Ensure that the power cable is 
connected properly to the interactive 
whiteboard.

 l Ensure that the interactive whiteboard is 
connected properly to the computer 
using a USB cable.

 l Ensure that the computer is on.

Flashing green  l Is in HID mode. It’s 
receiving power and is 
communicating 
successfully with the 
computer’s USB HID 
driver.

 l SMART Product Drivers 
isn’t installed.

This is normal mouse mode and you might 
not want to use tools such as the pens and 
the eraser. You can move the mouse pointer 
and perform mouse functions by touching 
the interactive surface. The Right-Click 
button on the pen tray might work, 
depending on the operating system you’re 
using. Neither the Keyboard nor the Help 
button work in HID mode.

 l To use the tools, install 
SMART Product Drivers.

 l To use all the features of the interactive 
whiteboard, install SMART software 
(smarttech.com/software).

Flashing amber Is in a Service mode or its 
firmware is being updated.

Wait until the download finishes. After the 
download is complete, the Ready light turns 
solid green.

https://www.smarttech.com/software


Chapter 5 Using and maintaining the interactive whiteboard

docs.smarttech.com/kb/144817 34

Using SMART Ink
If SMART Ink is installed on the connected computer, the dynamic (floating) 
toolbar for SMART Ink appears on the screen. You can use this toolbar to 
change the pen’s color, thickness or other properties temporarily, or use some 
of SMART Ink’s tools such as screen capture, spotlight, screen shade, and so 
on.

To learn more about using SMART Ink and its toolbar, visit the SMART Ink 
support page. Here are a few quick links to get you started:

 l Turning SMART Ink on or off

 l Open the toolbar

 l Close the toolbar (keep SMART Ink on, but hide the floating toolbar)

 l Using presentation tools, such as Spotlight, Magnifier, and Screen Shade

Writing, selecting, and erasing using object 
awareness
The SMART Board 800 series interactive whiteboard features object awareness, which means you can 
pick up a pen and write, select or erase without replacing the pen. SMART software interprets your intent 
when you press the interactive surface, based on both the type of tool you’re using and the size of the 
contact area.

 l If you touch the interactive surface with the pen, SMART software identifies its reflective surface, and 
you write or draw in digital ink on the screen.

 l If you touch the interactive surface with your finger, you perform a left click.

 l If you touch the interactive surface with an eraser, your palm or the side of your hand, SMART 
software identifies a large contact area, and you erase digital ink from the screen.

Important 

To prevent the interactive whiteboard from interpreting a pen as finger, do not cover the Pen ID 
feature above the pen’s nib.

Using Lockable Pen mode
If you want every touch on the interactive whiteboard surface to register as a specific tool—such as a 
pen, eraser, or Select tool—activate that tool and then, hold down a pen color button on the pen tray until 
its light flashes (about three seconds). The interactive whiteboard locks into that mode.

https://support.smarttech.com/docs/redirect/?product=ink
https://support.smarttech.com/docs/redirect/?product=ink
https://support.smarttech.com/docs/redirect/?product=ink&context=NoInk
https://support.smarttech.com/docs/redirect/?product=ink&context=OpenToolbar
https://support.smarttech.com/docs/redirect/?product=ink&context=Closing
https://support.smarttech.com/docs/redirect/?product=ink&context=PresentationTools
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Example 

If you want every touch to create red ink, press the red pen tray button until the red light flashes (about 
three seconds). Then every time you touch the board with your fingers, a pen or an eraser, you create 
red ink.

Note 

The selected pen tray light blinks to indicate you’re in Lockable Pen mode. To unlock the pen, press 
any pen tray color button.

Using gestures
Touch gestures enable you to use pre-determined commands without using the keyboard or mouse. 
With a series of touches on the interactive whiteboard screen, you can navigate pages, change the look 
of an object, erase digital ink and more.

Before you use gestures, you must enable the interactive whiteboard to recognize them. If you don’t 
enable gestures, only single-finger gestures are enabled.

Notes 

 l Gestures are enabled by default on Windows 7 or later operating systems and OS X 10.6 or later 
operating system software.

 l If gestures aren’t working as expected on your Windows computer, try the following (consult the 
documentation for your computer’s operating system for details about completing these actions):

 o In the Windows Control Panel, select Pen and Touch and disable the Windows Flick and 
Single-Finger Pan gestures to improve the performance of other gestures. For more 
information, see the Microsoft website.

 o From the Windows Control Panel, select Administrative Tools > Services and ensure that the 
Tablet PC Input Service is running and starts automatically.

 o In the Windows Device manager, select Human Interface Devices. If SMART Virtual Tablet 
PC driver (one of the SMART Product Drivers) isn’t visible, remove   SMART Product Drivers 
and then install them again.

 l Depending on the operating system and the specific application you’re using, some gestures 
might not work or could perform differently than described (see docs.smarttech.com/kb/144789).

Single-finger gestures
When you install SMART software, you can perform some gestures using one finger, including selecting 
objects and double-clicking. 

https://docs.smarttech.com/en/kb/144789
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You can also enable “flicks” on Windows 7 later or operating systems. To perform a flick, press the 
screen, and then drag quickly in one direction before releasing your finger. Flicks perform different 
actions depending on the direction of the flick, and you can customize flicks to perform different 
functions.

For more information about flicks, see the Microsoft website.

Single-finger gestures include the following:

Selecting and deselecting an object (clicking)
Quickly press and release the interactive surface to select or deselect an object or 
option. This performs a standard mouse click.

 

Note 

This gesture starts programs if the operating system is set to start applications with a single click.

Displaying menu options (right-clicking or control-clicking)
Press and hold the screen with your finger.

In SMART Notebook software, SMART Meeting Pro software, Windows and 
Microsoft Office programs, the right-click menu appears.

In Mac operating system software, menu options appear.

 

Dragging an object, scroll bar or window
Press and hold an object or scroll bar on the screen. Keep your finger on the 
screen and slowly move the object or scroll bar. When you reach the position you 
want, release your finger.
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Double-clicking
Quickly press and release the interactive surface twice in the same spot. This 
performs a standard double-click.

 

Note 

This gesture starts programs if the operating system is set to start applications on a double click.

Displaying the next and previous page
To display the next page, press the screen and then quickly press again directly to 
the right of that point.

 
To display the previous page, press the screen and then quickly press again 
directly to the left of that point.

 

Multi-finger gestures
You can perform some gestures using two or more fingers, including scaling, scrolling and manipulating 
objects. Multi-finger gestures include the following:

Displaying menu options (right-clicking or control-clicking)
Using two fingers on the same hand, press and hold the screen with one finger and then to press the 
screen directly to the right of that point with a second finger.

Lift the first finger from the screen, and then select a menu item with any finger.

Enlarging an area or object
Use one finger on each hand to press in the center of the area or object, and then 
drag your fingers away from each other.
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Reducing the scale of an object
Use one finger on each hand to press the screen at opposite ends of the area or 
object, and then drag your fingers toward each other. 

This gesture either scales a single object or the entire page, depending on the 
application.

 

Scrolling horizontally or vertically
Using two fingers on the same hand, press and hold the screen. Keeping your 
fingers on the screen, move up, down, left or right on the page. Release your 
fingers when you’re satisfied with the view.

 

Swiping to a different page
Press the screen with all four fingers on your hand, swipe 
your fingers to the right to display the previous page or to 
the left to display the next page, and then release your 
fingers.

 

Rotating an object
Place one finger on either side of the object you want to rotate. Keep one finger 
stationary, and quickly move your second finger around the object. Release your 
fingers from the screen when you’re satisfied with the angle.

 

Erasing digital ink
Using your flattened hand, palm, or fist, press the interactive surface and move 
your hand across the area you want to erase.
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Use a scrubbing motion to erase entire areas of digital ink.

 
To erase a large area of ink, move your hand in a circle around the area you 
want to erase, and then swipe your hand across the middle of the circle.

 

Multitouch gestures
Two people can work together to draw, erase or interact with content anywhere on the interactive 
surface at the same time.

You can use multitouch hand and finger gestures to toss, rotate or zoom in or out on objects and interact 
within SMART software.

Note 

Depending on the operating system and application you’re using, some gestures may not work or 
may perform differently than described. Windows 7 operating system and OS X 10.6 operating system 
software are multitouch operating systems.

Best practices for gestures and tools
Follow these guidelines when you use gestures and tools with the interactive product.
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Hold your fingers perpendicular (90°) to the interactive surface at the contact point.

90°

90°

Keep your thumb and other fingers away from the interactive surface. They can generate unintentional 
commands.
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Keep your other hand, elbows and loose clothing away from the interactive surface. They can generate 
unintentional commands.

For “click” commands, quickly tap your finger on the interactive surface. Also, make sure you lift your 
finger far enough away from the interactive surface between presses so that your finger is out of the 
interactive whiteboard cameras’ view.

For “erase” commands, use your palm or the bottom of your fist.
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When using the pen tray’s eraser, use the wide surface for large areas and the smaller, angled surface 
for smaller areas. Don’t use the edge of the eraser because this could be interpreted incorrectly.
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Tips for trouble-free performance
 l Connect the interactive whiteboard to a USB interface that’s recognized by the operating system.

 l Don’t obstruct the cameras’ view of the interactive whiteboard’s surface or edges. For example, 
don’t place magnets, stickers or adhesive tape on the interactive surface or rest any objects, 
including the pens, in the recess at the bottom of the interactive surface. This interferes with the 
corner cameras’ ability to detect your finger or pen tray tools.
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Safety tips for teachers
 l Tell students not to look directly at the light beam from the projector. Instead, encourage them to 

keep their backs to the projector when working at the interactive whiteboard. Before students turn 
to face the class, they should take a step sideways, out of the projector’s beam.

 l Make sure that you don’t look directly into the projector’s beam. Keep your back to the class when 
you write over a projected image. Step to the side of the interactive whiteboard before you turn to 
face the class.

 l Tell students not to touch the projector because it can become extremely hot during normal 
operation.

 l Don’t use a chair to increase a student’s reach. If your students can’t reach the top of the interactive 
whiteboard, you might need to remount a wall-mounted unit at a lower position.

Preventing damage to the interactive whiteboard
Although the SMART Board interactive whiteboard’s surface is very durable, take the following 
precautions to prevent damage to the interactive surface and other components.

 l Don’t set up and use the interactive whiteboard in an area with high levels of dust, humidity or 
smoke.

 l Don’t use sharp or pointed objects, such as ballpoint pens or pointers, as writing tools.

 l Replace the pen nib when the nib wears out.

 l Don’t use low-odor dry-erase markers because they can be very difficult to erase. Use standard 
(high-odor) dry-erase markers that show a warning to use them only in well-ventilated areas.

 l Don’t use adhesive tape on the interactive surface.

 l Don’t use abrasive erasers or harsh chemicals to clean your product.

 l Don’t use compressed air to clean the interactive whiteboard’s cameras. The force of the air could 
damage them.

Keeping the writing surface clean
With proper care, the SMART Board interactive whiteboard will provide years of trouble-free service. 
Follow these tips to keep the interactive whiteboard’s surface clean:

 l Don’t spray cleaner directly onto the interactive whiteboard’s surface. Instead, spray a light amount 
of cleaner on a cloth and then gently wipe the interactive surface.

 l Clean your interactive whiteboard at least every six months.

 l Don’t allow excess cleaner to flow onto the frame’s reflective surfaces or into the pen tray slots.
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 l The digital cameras located in the corners of the frame are protected from dust and dirt by 
windows. In extremely dusty environments, spray an alcohol-free household glass cleaner, such as 
Windex® cleaner, on a cotton swab and rub it gently on the windows. Don’t use compressed air to 
clean the cameras.

Important 

 o Turn the interactive whiteboard off before you clean it so that you do not scramble the 
desktop icons or inadvertently activate applications when you wipe the interactive surface.

 o To view dirt or streaks more easily, set the projector to standby (lamp off) mode.

Cleaning the pen tray
If the infrared sensors in the sides of the pen tools’ slots become obstructed by dirt, moisten a cotton 
swab with an alcohol-free household glass cleaner, such as Windex, and then carefully clean the 
infrared transmitter and receiver.

Updating SMART software
To update SMART software, go to the SMART software download page or use SMART Product Update 
(SPU).

To check for software updates

 1. Click the SMART software icon in the Windows notification area or the Mac Dock, and then select 
Check for Updates and Activation.

The SMART Product Update dialog box appears listing the SMART software products installed on 
your computer.

Note 

If you don’t see the Check for Updates and Activation option, contact the network administrator.

 2. Click the Update button beside the software you want to update.

The SMART software updates automatically.
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Transporting the interactive whiteboard
Save the original SMART Board 800 series interactive whiteboard packaging so that it’s available if you 
need to transport the interactive whiteboard. When required, repack it with as much of the original 
packaging as possible. This packaging was designed to provide the best possible protection against 
shock and vibration. If the original packaging is no longer available, you can purchase the same 
packaging directly from your authorized SMART reseller (smarttech.com/where).

If you prefer to use your own packaging materials, make sure you adequately protect the interactive 
whiteboard. Ship the interactive whiteboard in an upright position to deter shippers from placing heavy 
objects on it.

Removing the pen tray
It might be necessary to remove the pen tray when you transport or service the interactive whiteboard. 

Caution 

There are no user-serviceable parts inside the pen tray. Do not disassemble the pen tray. If dust or 
small items become wedged in the spaces around the buttons and prevent them from being pressed 
or causing constant button contact, remove the obstruction carefully.

Note 

Electrostatic discharge (ESD) protection isn’t required when performing the following procedure.

To remove the pen tray 

 1. Turn off the interactive whiteboard and disconnect the cables from the pen tray by disconnecting 
the power cable from the wall outlet and the USB cable from the computer.

 2. Remove the pens and the eraser from the pen tray.

 3. Reach under the pen tray and disconnect the USB cable.

 4. If you secured the pen tray to its brackets using two security screws, remove the screws and set 
them aside.

 5. If you secured the pen tray using a Kensington lock or similar device, unlock and remove the lock.

https://www.smarttech.com/where
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 6. Reach under the pen tray and pull down on the two large plastic clips. Because the ends of these 
clips project slightly downwards, they’re easy to locate.

 7. While applying downward pressure to the clips, gently slide the pen tray toward you until you can 
access the cables attached to the back of the pen tray.

 8. Carefully disconnect these cables before completely removing the pen tray from the two L-shaped 
metal brackets.

To reinstall the pen tray, simply reverse these steps. When you replace the pen tray on its supports, you’ll 
hear a click when it slides into place.



docs.smarttech.com/kb/144817 48

Chapter 7 Troubleshooting

Tips and resources for troubleshooting 48
Adjusting the projected image 48
Resetting the interactive whiteboard 49
Using the connection wizard 49
Using SMART Diagnostics 50

Checking the camera views 50
Checking the interactive whiteboard’s calibration 51

Troubleshooting the interactive whiteboard and related SMART products 53
Troubleshooting using the Ready light 53

Flowchart 1: Getting started 54
Flowchart 2: The Ready light is off 55
Flowchart 3: The Ready light is solid red 56
Flowchart 4: The Ready light is flashing green 56
Flowchart 5: The Ready light is solid green but pen tray tools behave unexpectedly 58
Flowchart 6: The Ready light is solid green but the interactive whiteboard isn’t responsive 59

Getting support and finding the serial number 60

Tips and resources for troubleshooting
You can use these tips and resources when troubleshooting the interactive whiteboard.

Adjusting the projected image
Alignment errors occur when the projected image isn’t perpendicular to the screen. Alignment errors can 
occur when you mount the interactive whiteboard on an uneven surface or a wall that has obstructions, 
or if you position the projector too far from the vertical or horizontal center of the interactive whiteboard.

If the projector isn’t installed in a fixed location, you can correct many image problems by shifting your 
projector or adjusting its alignment settings and zoom lens.

If you are using a SMART projector, refer to the interactive whiteboard system’s user’s guide. If you’re 
using an Epson® projector, consult the projector’s documentation.
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Note 

Adjust the image size and shape while projecting a full-screen image such as your projector’s splash 
screen, unless the splash screen image is much smaller than the computer’s projected image. Before 
you adjust the projected image, set the computer’s resolution and refresh rate (see Configuring the 
computer settings on page 20).

Resetting the interactive whiteboard
If the interactive whiteboard behaves erratically or becomes unresponsive, possibly because of an 
electrostatic discharge, a power interruption or some other event, you might be able to restore normal 
operation by resetting the interactive whiteboard. This turns the power off and back on, restarting all the 
interactive whiteboard’s components.

To reset the interactive whiteboard 

  Disconnect the power cable from the back of the pen tray and reconnect it after a few seconds.

OR

Press the Reset button briefly (less than three seconds) on the bottom of the pen tray.

All the pen tray indicator lights flash sequentially twice and the interactive whiteboard resets.

Important 

If you accidentally press the Reset button for longer than three seconds, the interactive whiteboard 
goes into a service mode and the pen tray flashes amber. To get the interactive whiteboard out of the 
service mode, disconnect the power cable from the back of the pen tray and reconnect it afte a few 
seconds.

Note 

The Reset button is recessed so that it can’t be triggered accidentally. Use a long, narrow object, such 
as a ball-point pen, to press this button.

Using the connection wizard
SMART Settings includes a connection wizard for troubleshooting problems with the connection between 
the computer and interactive whiteboard.
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For example, you may need to configure a serial port manually in the following situations:

 l The computer’s operating system doesn’t support plug and play.

 l The Found New Hardware wizard doesn’t appear.

 l You connected the interactive whiteboard to a power source after you started your computer.

 l The Ready light remains red after you start SMART Board Tools.

To troubleshoot connections

 1. Click the SMART Board icon  in the notification area (Windows) or menu bar (Mac) and select 
SMART Settings.

Note 

If your computer isn’t currently connected to an interactive whiteboard, the SMART Board icon 

includes an X in the lower-right corner .

 2. Click Connection Wizard.

The SMART Connection Wizard appears.

 3. Follow the on-screen instructions.

Using SMART Diagnostics
If you touch the interactive whiteboard’s surface and nothing happens, there is no digital ink, or the ink 
appears in some locations and not in others, use SMART Board Diagnostics to help identify and resolve 
these issues.

Important 

Do not change diagnostic settings unless asked to do so by SMART Support.

Checking the camera views
If nothing happens when you touch the interactive whiteboard surface, ensure that nothing is obscuring 
any of the cameras’ views.

To check camera views

 1. Press the SMART software icon in the Windows notification area or Mac Dock, and then press 
Control Panel.

The SMART control panel opens.
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 2. Select About Software and Product Support > Tools > Diagnostics.

The SMART Board Diagnostics screen opens.

 3. Select View > SBX800/SBID8070i Bar.

The SBX800/SBID8070i bar appears.

 4. Click View.

The camera view window appears.

Note 

The bottom-left camera is Camera 0, the top-left camera is Camera 1, the top-right camera is 
Camera 2 and the bottom-right camera is Camera 3.

 5. Click Update to show what each of the four cameras sees. This can take several moments.

Each bar represents a picture from a camera, and the number beside the bar tells you which 
camera took the corresponding picture. This image shows normal camera views.

 6. If one of the cameras’ views remains black, the camera is obstructed or can’t locate the reflective 
surface on the interactive whiteboard inner frame. This image is an example of a camera view 
obscured by a pen or other object.

Check the camera lens and ensure that nothing is obstructing the view and that nothing is affixed to 
the interactive surface.

 7. Click Save Image and then save the file with your choice of file name and location.

Tip 

It’s a good idea to save the file to the SMART Technologies folder. You can save the image with 
the log file for future reference or to email to a technical support representative.

Checking the interactive whiteboard’s calibration
If no digital ink appears or appears only in certain areas when you write on the interactive whiteboard, 
the interactive whiteboard could be incorrectly calibrated. You can test the calibration using 
SMART Board Diagnostics Tracker utility.
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To check the interactive whiteboard’s calibration

 1. Press the SMART software icon in the Windows notification area or Mac Dock, and then press 
Control Panel.

The SMART control panel opens.

 2. Select About Software and Product Support > Tools > Diagnostics.

The SMART Board Diagnostics screen opens.

 3. Select View > SBX800/SBID8070i Bar.  

The SBX800/SBID8070i bar appears.

 4. Click Tracker.

The screen becomes white.

 5. Touch the interactive screen with a pen, finger or eraser.

 6. Verify that the tracking rays overlap.

This image shows two contact points: a finger and an eraser.

 7. If the rays don’t overlap, and the rays change from colored to black, calibrate the cameras (see 
page 22).
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Notes 

 l If one or more of the lines don’t move or don’t appear, a camera is obstructed or isn’t working 
properly.

 l If intermittent black lines appear, a second object, such as your sleeve, is touching the screen 
while you write.

Troubleshooting the interactive whiteboard and 
related SMART products
The Support section of the SMART website includes information about resolving a variety of common 
problems with the interactive whiteboard and related SMART products.

Seesupport.smarttech.com/docs/sb800troubleshooting

Troubleshooting using the Ready light
You can troubleshoot the interactive whiteboard using the Ready light, together with other observable 
symptoms and behaviors. Before you start troubleshooting, see Using the Ready light on page 32 to 
locate the Ready light, and then familiarize yourself with its states during normal operation. The 
following flowchart directs you to the next stage in the troubleshooting process.

https://support.smarttech.com/docs/sb800troubleshooting
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Flowchart 1: Getting started
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Flowchart 2: The Ready light is off
When the Ready light is off, the interactive whiteboard isn’t 
receiving power.

Press the Reset button on the bottom of the pen tray to reset the 
interactive whiteboard. Alternatively, disconnect the power cable 
at the wall outlet and connect it again.

When you reset the interactive whiteboard, all the pen tray lights 
flash sequentially twice, indicating successful communication with 
the SC14 controller. If they flash continuously, reset the interactive 
whiteboard again. If this doesn’t solve the issue, you might need to 
replace the pen tray.

Check that the power cable is connected to the correct receptacle. 
The audio and power receptacles are located beside each other 
on the back of the pen tray.
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Flowchart 3: The Ready light is solid red
A red Ready light indicates that the interactive whiteboard is 
receiving power but isn’t communicating successfully with the 
computer. In most cases, pen tray lights don’t turn on and the 
screen doesn’t respond to touch.

The interactive whiteboard is connected to the computer with a 
USB cable, and to the wall outlet with a power cable. You can 
access these cables by reaching underneath the pen tray.

The USB cable must not exceed 16' (5 m).

Press the Reset button on the bottom of the pen tray to reset the 
interactive whiteboard. Alternatively, disconnect the power cable at 
the wall outlet, and connect it again.

 

 

Flowchart 4: The Ready light is flashing green
This is the normal mouse mode state when SMART Product Drivers isn’t installed on the computer. This 
mode can be useful for occasional or guest users who don’t require the use of SMART Board Tools or 
pen tray functions.
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Before you can use SMART Board Tools or the pen tray pens and eraser, SMART Product Drivers must 
be installed and running. If the SMART software icon doesn’t appear in the Windows notification area or 
Mac Dock, you must start SMART Product Drivers.

To use all the features of the SMART Board 800 series 
interactive whiteboard, go to smarttech.com/downloads to 
download SMART software and install it on your computer. 

To determine whether the SMART Board software service is 
running, open the SMART control panel and check the 
message that appears at the bottom. Start SMART Board 
software service.

 

 

https://www.smarttech.com/downloads
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Flowchart 5: The Ready light is solid green but pen tray tools behave 
unexpectedly

A solid green Ready light indicates that the 
interactive whiteboard is working properly. 
However, if the pen tray tools don’t work as 
expected, use this flowchart to troubleshoot the 
interactive whiteboard.

If another user has reassigned the pen, eraser or 
button functions, the tools might not work as 
expected. You can return them to normal 
operation using the SMART control panel to 
change SMART hardware settings.

Use camera views to examine the images 
reflected to the cameras from the inner edge of 
the frame and to determine which cameras are 
faulty.

SeeChecking the camera views on page 50

Press the Reset button on the bottom of the pen 
tray to reset the interactive whiteboard. 
Alternatively, disconnect the power cable at the 
wall outlet and connect it again.

Calibrate the cameras to ensure that they 
accurately track your fingers and the pens.

To update the firmware, run the SMART Firmware 
Update application.
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Flowchart 6: The Ready light is solid green but the interactive whiteboard 
isn’t responsive

Press the Reset button on the bottom of the 
pen tray to reset the interactive whiteboard. 
Alternatively, disconnect the power cable at 
the wall outlet, and connect it again.

To check firmware versions, go to 
SMART Board Diagnostics and then select 
View > SBX800/SBID8070i Bar > Version > 
Update. A table appears listing the 
firmware version currently running in each 
camera. If a camera isn’t operating, you’ll 
see zeros.

Use camera views to examine the images 
reflected to the cameras from the inner 
edge of the frame and to determine which 
cameras are faulty.

SeeChecking the camera views on 
page 50

Calibrate the cameras to ensure that they 
accurately track your fingers and the pens.

SeeCalibrating the interactive whiteboard 
on page 22

To update the firmware, run the SMART 
Firmware Update application.
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Getting support and finding the serial number
SMART Support welcomes your call. However, if you experience difficulty with the SMART Board 
interactive whiteboard, you might want to contact your local reseller first. Your reseller can often resolve 
the issue without delay.

You can find a list of parts and service parts diagrams for the interactive whiteboard or interactive 
whiteboard system on the SMART support website (smarttech.com/support). To order parts, contact 
your local reseller (smarttech.com/where).

Before contacting SMART Support, make note of the SMART Board interactive whiteboard’s serial 
number. If you printed this manual, you can make note of the serial number in the inside cover of this 
manual.

To determine the interactive whiteboard’s serial number

  You can find the serial number in two places: on the back of the SMART Board interactive 
whiteboard, and on the bottom right-hand edge of the interactive whiteboard’s frame (the side).

The serial number on the SMART Board interactive whiteboard always begins with the letters SBX, 
followed by the interactive whiteboard’s model number, for example, SBX880-xx-xxxxxx. The serial 
number can include numbers, letters and hyphens.

Note 

Make sure you include all the numbers, letters and hyphens in the serial number when contacting 
technical support.

https://www.smarttech.com/support
https://www.smarttech.com/where
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Certification and compliance

Hardware environmental compliance
SMART Technologies supports global efforts to ensure that 
electronic equipment is manufactured, sold, and disposed of in 
a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment and 
Battery regulations (WEEE and Battery Directives)
Electrical and electronic equipment and batteries 
contain substances that can be harmful to the 
environment and to human health. The crossed-out 
wheeled bin symbol indicates that products should be 
disposed of in the appropriate recycling stream and not as 
regular waste. 



docs.smarttech.com/kb/144817

SMART Technologies
smarttech.com/support

smarttech.com/contactsupport

https://www.smarttech.com/support
https://www.smarttech.com/contactsupport

	Cover
	Important information
	Safety warnings and cautions
	Other precautions

	Contents
	Chapter 1 About the SMART Board 800 series interactive whiteboard
	Identifying the components of the SMART Board 800 series interactive whiteboard
	Highlights
	Software
	Dual sketch capabilities
	SMART Ink
	Touch and gestures
	Pen tray
	Durable surface and dry erase
	Wall-mount bracket
	Cables
	Security cable lock

	Understanding how the SMART Board interactive whiteboard works
	Other components

	Included parts and accessories
	Pens
	Eraser
	Wall-mounting kit
	USB cable
	Extended Control Panel (ECP)
	Appliance Control Panel (ACP)
	Power supply

	Optional accessories

	Chapter 2 Installing and securing the SMART Board interactive whiteboard
	Environmental requirements
	Installing the SMART Board interactive whiteboard
	Installation tips
	Replacing an existing interactive whiteboard on drywall
	Securing the pen tray to the interactive whiteboard
	Securing the pen tray to the brackets


	Chapter 3 Connecting a computer
	Connecting the interactive whiteboard to the computer
	Installing SMART Product Drivers
	Configuring the computer settings
	Calibrating and orienting the interactive whiteboard
	Connecting a guest laptop

	Chapter 4 Calibrating and orienting the interactive whiteboard
	Calibrating the interactive whiteboard
	Orienting the interactive whiteboard

	Chapter 5 Using and maintaining the interactive whiteboard
	Getting started
	Turning the interactive whiteboard on and off
	Power buttons and indicators
	Using the Extended Control Panel (ECP)
	Using the Application Control Module (ACM)

	Using the pen tray
	Pen tray buttons
	Customizing the pen tray buttons

	Using the Ready light
	Using SMART Ink
	Writing, selecting, and erasing using object awareness
	Using Lockable Pen mode

	Using gestures
	Single-finger gestures
	Selecting and deselecting an object (clicking)
	Displaying menu options (right-clicking or control-clicking)
	Dragging an object, scroll bar or window
	Double-clicking
	Displaying the next and previous page

	Multi-finger gestures
	Displaying menu options (right-clicking or control-clicking)
	Enlarging an area or object
	Reducing the scale of an object
	Scrolling horizontally or vertically
	Swiping to a different page
	Rotating an object

	Erasing digital ink
	Multitouch gestures
	Best practices for gestures and tools


	Chapter 6 Maintaining your interactive whiteboard
	Tips for trouble-free performance
	Safety tips for teachers
	Preventing damage to the interactive whiteboard
	Keeping the writing surface clean
	Cleaning the pen tray

	Updating SMART software
	Transporting the interactive whiteboard
	Removing the pen tray

	Chapter 7 Troubleshooting
	Tips and resources for troubleshooting
	Adjusting the projected image
	Resetting the interactive whiteboard
	Using the connection wizard
	Using SMART Diagnostics
	Checking the camera views
	Checking the interactive whiteboard’s calibration


	Troubleshooting the interactive whiteboard and related SMART products
	Troubleshooting using the Ready light
	Flowchart 1: Getting started
	Flowchart 2: The Ready light is off
	Flowchart 3: The Ready light is solid red
	Flowchart 4: The Ready light is flashing green
	Flowchart 5: The Ready light is solid green but pen tray tools behave unexpec...
	Flowchart 6: The Ready light is solid green but the interactive whiteboard is...

	Getting support and finding the serial number

	Certification and compliance

